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Fundamentals
CLO-SET Virtual Showroom Workflow

1. In CLO-SET virtual showroom, you will be able to create 2 types of the background environment.
Please well prepare the 2D or 3D images accordingly

2D Image
image ratio : 16:9

Resolution: up to 8192px * 4096px, 100mb
File format:  png, svg, jpg, jpeg, webp

the image can be taken by smart phone & professional camera

3D Panoramic Image
image ratio : 16:9

Resolution: up to 8192px * 4096px, 100mb
File format:  png, svg, jpg, jpeg, webp, HDRI

the image can be taken by smart phone, professional camera,
& the camera with panoramic features
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2. Please also prepare the contents which will be showcased in the virtual showroom in advanced

3D Files
Supported File format:

CLO default format e.g. zprj, zpac, zfab etc.
Common 3D format, e.g. glb, obj, fbx etc.

Please read this manual for details HERE

2D Files
Supported File format:

jpg, png, jpeg, gif

Fundamentals
CLO-SET Virtual Showroom Workflow

https://support.clo-set.com/hc/en-us/articles/8352295404943-Supported-File-Formats-in-3D-Viewer
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3. Upload all 3D files to the workroom in CLO-SET

a. Click the upload button on the upper left of 
workroom

b. select to upload single or multiple files
c. attach the file from your computer

A

B

Fundamentals
CLO-SET Virtual Showroom Workflow
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3. Upload all 3D files to the workroom in CLO-SET

d. Once the styles are uploaded, go to it’s content page and edit it’s description & all basic info at the left 
hand corner. the info will be displayed in the virtual showroom lastly

Fundamentals
CLO-SET Virtual Showroom Workflow
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4. create a new assortment, and put all uploaded 3D file to the assortment

a. Click ‘create assortment’ on the top left of workroom level

b. A new assortment will be created

Fundamentals
CLO-SET Virtual Showroom Workflow
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4. create a new assortment, and put all the uploaded 3D file to the assortment

a. Go back to the workroom and select all 3D files

b. click ‘assortment’ in the toggle bar

c. select the assortment you have newly created

d. all 3D files will be linked to the assortment

A

B

C

Fundamentals
CLO-SET Virtual Showroom Workflow
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5. In the assortment, click ‘Create Virtual Showroom’ on the top right to start the setup

Fundamentals
CLO-SET Virtual Showroom Workflow
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6. Firstly, please complete the basic information and Environment

- Name

- Environment

- the background of the showroom

- can be either 2D or 3D images

- when you click select, you can 

attach multiple images from 

your desktop

- Custom Logo 

Click ‘create’ when it is completed

Fundamentals
CLO-SET Virtual Showroom Workflow
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7. Secondly, please complete the virtual showroom in the preview page

add & edit environment

- by clicking on each background thumbnail, you 

can switch to other environment

- by clicking ‘add space’ on the top, you can attach 

additional 2D/3D images as the background

Fundamentals
CLO-SET Virtual Showroom Workflow
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7. Secondly, please complete the virtual showroom in the preview page

3D environment viewer

- you are able to view the environment in 3D at the 

middle, if you have attached panoramic images

- the navigation would be same as 3D content live 

viewer

- Left/ Right button: rotation

- Wheel : Zoom in or out

Add content

- by clicking the cross icon, you can add 3D & 2D 

contents in the environment 

Fundamentals
CLO-SET Virtual Showroom Workflow
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7. Secondly, please complete the virtual showroom in the preview page

For adding 3D content,

A. rotate your view point to the specific area

B. click ‘3D content’ of the ‘cross’ icon

C. drag one of the 3D file to the environment

A

B

C

Fundamentals
CLO-SET Virtual Showroom Workflow
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7. Secondly, please complete the virtual showroom in the preview page

For adding 3D content,

D. the new tag is added on the environment,

you can drag and match it to the garment in 

the environment

E. click ‘edit’ to adjust the content

a. the display name

b. to replace it as another content if 

needed

c. the sport icon color and shape

F. click ‘save’ to complete the edit

E

F

Fundamentals
CLO-SET Virtual Showroom Workflow
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7. Secondly, please complete the virtual showroom in the preview page

For adding 2D content,

A. rotate your view point to the specific angle

B. click ‘2D content’ of the ‘cross’ icon

C. the tag of the 2D content is added in the environment, 

you can drag and match it to the specific garment

D. you edit the content at the right hand column

a. displayed name

b. attach the 2D content from your desktop

c. description of the content

d. spot icon color & shape

E. click ‘save’ to complete the edit

A

B

C

D

Fundamentals
CLO-SET Virtual Showroom Workflow
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7. Secondly, please complete the virtual showroom in the preview page

For adding Navigation, 

- a new tag will be added in the environment

- when the virtual showroom is published, visitor can 

click this tag to access to another 

environment/another showroom

For adding other content,

- a new tag will be added in the environment, which will 

redirect the visitor to another hyperlink (URL)

Fundamentals
CLO-SET Virtual Showroom Workflow
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8. Finally, you can publish the completed virtual showroom ro live, and share it to other people

a. Click ‘publish to live’ on the upper right corner b. the published virtual showroom can be shared by 
hyperlink at the right bottom corner

Fundamentals
CLO-SET Virtual Showroom Workflow



Copyright © 2024 CLO Virtual Fashion Inc. All Rights Reserved. CONFIDENTIAL

8. Finally, you can publish the completed virtual showroom ro live, and share it to other people

By clicking each tag, the 3D content will be showcased in the 3D live viewer with description

Fundamentals
CLO-SET Virtual Showroom Workflow
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For further demonstration, please check our tutorial video in our Youtube channel.

Fundamentals
CLO-SET Virtual Showroom Workflow

http://www.youtube.com/watch?v=F0xq1WP0XiM
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Method 1
By taking the pictures of your real showroom
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Method 1
By taking the pictures of your showroom in reality

Please well prepared either the 2D or 3D panoramic images as the background of the showroom.

For 2D images, 

A. you may take the images of the actual showroom in different angles and locations. Please read the requirement of the photo in slide 4

B. then, you may directly import all the images to CLOSET when you setup the virtual showroom

A B



Copyright © 2024 CLO Virtual Fashion Inc. All Rights Reserved. CONFIDENTIAL

Method 1
By taking the pictures of your showroom in reality

Please well prepared either the 2D or 3D panoramic images as the background of the showroom.

For 2D images, 

C. In the virtual showroom preview page, you can add the navigation tag to redirect the visitor to the other imported images 

D. and you may follow the later workflow in the Fundamentals to complete the showroom

C
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Method 1
By taking the pictures of your showroom in reality

For 3D panoramic images, it can be auto generated by the camera with panoramic features. 
Or it can be created by using Photoshop, here is the steps:

A. Set your camera/cell phone at the center of the 

actual showroom.

B. then, by rotating the camera in each 45 degrees, 

taking 8 images to capture the whole 

environment of the showroom, here is the 

suggested spec for the images:

a. vertical image

b. 1920 x 1080 or upper

c. Field of View - 13mm or lower

d. take the images with camera stands to 

ensure all images are in same view level

e. for each images, please make sure that 

there are some overlapped part

A

45 Degree

1

2

3

4

5

6

7

8
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Method 1
By taking the pictures of your showroom in reality

For 3D panoramic images, it can be auto generated by the camera with panoramic features. 
Or it can be created by using Photoshop, here is the steps:

A. Set your camera/cell phone at the center of the 

actual showroom.

B. then, by rotating the camera in each 45 degrees, 

taking 8 images to capture the whole 

environment of the showroom, here is the 

suggested spec for the images:

a. vertical image

b. 1920 x 1080 or upper

c. Field of View - 13mm or lower

d. take the images with camera stands to 

ensure all images are in same view level

e. for each images, please make sure that 

can be overlapped part

IMAGE 1 IMAGE 2

can be overlapped
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Method 1
By taking the pictures of your showroom in reality

For 3D panoramic images, it can be auto generated by the camera with panoramic features. 
Or it can be created by using Photoshop, here is the steps:

A. Set your camera/cell phone at the center of the 

actual showroom.

B. then, by rotating the camera in each 45 degrees, 

taking 8 images to capture the whole 

environment of the showroom, here is the 

suggested spec for the images:

a. vertical image

b. 1920 x 1080 or upper

c. Field of View - 13mm or lower

d. take the images with camera stands to 

ensure all images are in same view level

e. for each images, please make sure that 

can be overlapped part

IMAGE 1 IMAGE 2

no overlapped area
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Method 1
By taking the pictures of your showroom in reality

For 3D panoramic images, it can be auto generated by the camera with panoramic features. 
Or it can be created by using Photoshop, here is the steps:

C. When all images are ready, open photoshop and click 

File > Automate > Photomerge

D. the photomerge window will 

be popped up

- click ‘browse’ to attach 

all images

- tick all the options at the 

bottom

- click okay and 

photoshop will generate 

the panoramic image in 

a seconds
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For 3D panoramic images, it can be auto generated by the camera with panoramic features. 
Or it can be created by using Photoshop, here is the steps:

Method 1
By taking the pictures of your showroom in reality

E. when the image is generated, change the canvas size to 16:9

F. there will be some empty spaces after the canvas dimension is changed. by using different tools, extend the ceiling and floor to cover the empty 

space (e.g. generative fill, distort transform etc.) Remark: don’t distort middle area where the garment is displayed

Before After
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For 3D panoramic images, it can be auto generated by the camera with panoramic features. 
Or it can be created by using Photoshop, here is the steps:

Method 1
By taking the pictures of your showroom in reality

G. please make sure that the vertical edge is seamless when it is tiled in 3D. You can use the photo editing tools to further adjust it

the 2 vertical edges it should be seamless when tiling
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For 3D panoramic images, it can be auto generated by the camera with panoramic features. 
Or it can be created by using Photoshop, here is the steps:

Method 1
By taking the pictures of your showroom in reality

H. when the image is completed, it can be exported based on the requirement in slide 4

Remark: please make sure that the image scale is in 16:9, otherwise the environment will be distorted when it is displayed in 3D 

I.  follow the later workflow in the Fundamentals to complete the showroom
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Method 2
By using the VS background preset

provided by CLO-SET
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1. To use the background preset provided by CLO-SET,
please download the preset panoramic images from CLO-SET Website first HERE (at the bottom)

Method 2
By using the VS background preset provided by CLO-SET

https://support.clo-set.com/hc/en-us/articles/7353597688591-Virtual-Showroom#h_01H570RFSHKRKYPQ938B1SVKTB
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2. At the same time, please render your 3D contents in PNG format respectively 
As we need to use photoshop to put the rendered images in the showroom. please render it in specific angles 

Method 2
By using the VS background preset provided by CLO-SET
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3. Go to photoshop and click 3D > Spherical Panorama > Import Panorama
4. Import the background preset from CLO-SET
5. The background will be displayed in 3D. you can navigate it by the gizmo tool to start the editing
6. Put the rendered content images in the background to complete the virtual showroom. 
7. Export the completed showroom images and continue the workflow 

Method 2
By using the VS background preset provided by CLO-SET
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Method 3
By building the virtual showroom in CLO and 

export it to CLO-SET
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A. create the backdrop by pattern pieces

a. it should be an closed space 

b. Tips: You can set these ‘wall’ patterns to be 

low-res as we will not going to simulate it. 

It is fine to have higher Particle Distance

c. save the project file (zprj) first

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET
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B. add the props & furniture in the 

current showroom file, e.g. sofa, rack 

etc.

a. the props can be created by 

other 3D modelling software 

(e.g. blender), or browsed 

from Connect Store

b. in CLO, click File > import to 

add the props in the 3D 

environment one by one

c. Compatible formats: obj, fbx, 

glb, OpenCollada, Alembic 

etc.

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

a b

https://connect.clo-set.com/
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B. add the props & furniture in the 

current showroom file, e.g. sofa, rack 

etc.

a. the props can be created by 

other 3D modelling software 

(e.g. blender), or browsed 

from Connect Store

b. in CLO, click File > import to 

add the props in the project 

file one by one

c. Compatible formats: obj, fbx, 

glb, OpenCollada, Alembic 

etc.

d. position the props one by one

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

d

https://connect.clo-set.com/
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C. add the 3D garment in the current showroom 

file

a. the 3D garment can be displayed in 

different forms, e.g. folded garment, 

garment hanged on rack, garment on 

mannequin etc.

well prepared the 3D file(zprj.) 

separately first.  

b. when each 3D file(zprj.) is completed, 

export the 3D garment as fbx/glb by 

clicking file > export 

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET
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C. add the 3D garment in the current showroom 

file

c. once the 3D garments are all exported 

as fbx/glb, go back to the virtual 

showroom file

d. add the fbx/glb file to the current 

showroom file by clicking file > import

e. position the 3D garment in the 

showroom one by one 

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET
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D. Adjust the positions and layout of all 
items inside the showroom

E. If it is ready, go to ‘render > render’ to 
generate the panoramic image

a. Open ‘Camera Properties’ 
settings, and set the ‘Lens’ 
type as ‘Panorama’

b. keep the field of view as 
default as 60 
(recommended value to make 
sure the showroom 
environment will not be 
distorted when it is displayed 
in 360 degree)

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

a

b
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D. If it is ready, go to ‘render > 
render’ to generate the 
panoramic image

c. preview the render 
result by clicking 
‘interactive render’

d. adjust your view in the 
3D window to determine 
the position of the 
camera 

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

c

d
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Tips: to adjust the camera position accurately, you can do it in animation mode.  add a new keyframe, turn on camera viewfinder, change the camera 
position by the gizmo 

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

1

2 31. Go to animation mode
2. add a new keyframe
3. click ‘camera viewfinder’
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Tips: to adjust the camera position accurately, you can do it in animation mode.  add a new keyframe, turn on camera viewfinder, change the camera 
position by the gizmo 

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

4. zooming out in your 3D window and you will 
be able to view the ‘camera’ in the 3D window; 
by using it’s gizmo tool, you can set the 
position of the gizmo accurately

5. you can preview the view of the camera from 
the ‘camera preview’ window

6. if needed, right click the 3D window and 
choose ‘custom view’, 
and click the ‘camera’ icon to save the 
camera position

4

5

6
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Tips: difference when the camera position is set 
in different location 

Example 1

1. The view in 3D window
2. The rendered panorama image
3. the position of the camera

Even though render result is different in the 
panorama image, it will not affect the final result 
when it is displayed in 360 degree in virtual 
showroom

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

1

2

3
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For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Tips: difference when the camera position is set 
in different location 

Example 2

1. The view in 3D window
2. The rendered panorama image
3. the position of the camera

Even though render result is different in the 
panorama image, it will not affect the final result 
when it is displayed in 360 degree in virtual 
showroom

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

1

2

3
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D. If it is ready, go to ‘render > render’ to generate the panoramic image
f. Don’t forget to set up the lighting through the render window. The lighting must be added inside the room, otherwise the room will be dark.

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET

Tips: Add lighting manually from the render window, and set the position from the 3D window. Note: Deactivate the Show (Render) so the lighting 
mesh doesn’t show in the final render.
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D. If it is ready, go to ‘render > render’ to generate the panoramic image
g. when everything is finalised, click ‘Final render(image view)’ to generate the panoramic image

E. follow the later workflow in the Fundamentals to complete the showroom in CLO-SET

For this method, you might need to build up the backdrop and the virtual showroom fully in CLO first and render the result as 
panoramic images. Here is the suggested steps:

Method 3
By building the virtual showroom in CLO and export it to CLO-SET
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Method 4
By building the virtual showroom from 

other 3D modelling software and 
export it to CLO-SET
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This method guides users on creating their own 360-degree backgrounds: setting up a showroom within the CLO3D software and 
transferring it to another 3D software for rendering 360-degree images. Blender is one of the software options.

Method 4
By building the virtual showroom from other 3D modelling software and export it to CLO-SET

Example A Example B

https://streaklinks.com/BvzHKHDEhFlJ2TUIpgnwROS5/https%3A%2F%2Fstyle.clo-set.com%2Fvirtualshowroom%2F883723%2Flive?email=iris.dieu%40clo3d.com
https://streaklinks.com/BvzHKHLq6h8w_lcu-AANi3Ep/https%3A%2F%2Fstyle.clo-set.com%2Fvirtualshowroom%2F861198%2Flive?email=iris.dieu%40clo3d.com
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Method 4
By building the virtual showroom from other 3D modelling software and export it to CLO-SET

1. Well prepared all the 3D project files and export it as glb or fbx format one by one
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Method 4
By building the virtual showroom from other 3D modelling software and export it to CLO-SET

2. import the glb files to blender: 
a. Open Blender > Select ‘General’ environment > Delete the cube placed in the center of the window > File > Import > GLTF/GLB

1. Open Blender > Select ‘General’ 
environment

2. Delete the cube placed in the center of the 
window

3. File > Import > GLTF/GLB
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Method 4
By building the virtual showroom from other 3D modelling software and export it to CLO-SET

3. Build up your 3D showroom in blender
a. Similar to CLO, we will have 3D window where contains our showroom, lights, camera, etc. on the LHS. On the Top-RHS, it is similar to CLO Object 

Browser, where contains a list of things inside the current project, and when we click on any of them, we can find its data and we can adjust them 

in the Bottom-RHS window (eg. increase the scale of the showroom to have a wider showroom).
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Method 4
By building the virtual showroom from other 3D modelling software and export it to CLO-SET

4. Re-locate the camera to the center of the showroom:
a. Select the Camera in Object Browser > adjust the Location and Rotation. It should be placed inside the showroom, and you can imagine that the 

position of the camera is the placement that you are standing in the space.

A. Suggest that the camera should be placed 
90 degrees perpendicular to the ground, 
so that when rendering 360 degrees, the 
camera will rotate 360 degrees around the 
y axis.

B. The view/scene that the camera is 
determined to point at in the 1st frame will 
be the main face of the Virtual Showroom. 
This means that when we open the 
showroom on CLOSET, we will see that 
scene first

A

A

B
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Method 4
By building the virtual showroom from other 3D modelling software and export it to CLO-SET

5. Render the 3D showroom as panorama image 
a. You can refer on the tutorial here to render in Blender: LINK

b. Adjust/Set up some recommended setting for the camera and then you can start rendering:

1. Change Render Engine to 
Cycles (Default is Eevee)

2. Change Render Image 
Resolution. Should keep the 
ratio is 2:1

3. Change the Camera Lens 
Type to Panoramic & 
Panorama Type to 
Equirectangular

4. Start Rendering out: Go to 
Render > Render Image

1 2 3 4

https://www.youtube.com/watch?v=_QkuoHbQrCc
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Thank you


